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Chapter 1 – Overview of AWM

What AWM Does

AWM is a planning/design tool for animal feeding operations that can be used to estimate the production of manure, bedding, process water and determine the size of storage/treatment facilities.  The procedures and calculations used in AWM are based on the USDA-NRCS Agricultural Waste Management Field Handbook.

AWM uses the concepts of “Manure Master” to produce a gross nutrient balance but does not track mass or concentration of nutrients for determining land application rates or for other utilization components.

Features of AWM

· Provides manure characteristics for eight animal types with the ability to modify these characteristics and add animal types as necessary.

· Accounts for bedding, wastewater, flush water and other additions to the waste stream.

· Tracks liquid and solid wastes produced in multiple locations through multiple waste streams.

· Develops separation, storage, and treatment components for liquid and solid wastes that are defined as “Management Trains”.

· Estimate precipitation and runoff entering the “Management Train”..

· Sizes storage facilities using a defined storage period or drawdown dates specified by the user.

· Develops a monthly water and waste budget for each treatment/storage component.

· Provides a calculator for converting units and performing computations.

· Produces a gross nutrient balance from target yields and crop acreage specified for crops listed in the crop database.

· Provides a schematic drawing for each treatment/storage component.

· Generates a standard or custom report to document the system design.

User Support

User support can be obtained from the USDA-NRCS National Technology Support Centers. Contact Bill Reck at (336) 370-3353/ bill.reck@gnb.usda.gov, Darren Hickman at (817) 509-3303/ darren.hickman@ftw.usda.gov, or Charles Zuller at (503) 273-2423/ charles.zuller@por.usda.gov. Programming support for errors or omissions is provided by Harbans Lal, who can be reached at (503) 273-2441/ harbans.lal@por.usda.gov.
Future Enhancements

USDA-NRCS solicits the input of users to help determine the priority of potential enhancements to AWM.  Please contact programming support to let us know what enhancements would be of value to you.
Chapter 2 – Installing and
Starting AWM

What You Need to Use AWM

System requirements:

· Any IBM-compatible machine with at least a 400 Mhz processor.

· Microsoft Windows 2000/XP
· Microsoft Access 2002 or later
· At least 128 megabytes of memory

· At least 100 megabytes of hard drive storage space

Installation on CCE and Non-CCE Machines

AWM may be installed on both USDA Common Computing Environment (CCE) machines and non-CCE machines.  The AWM installation program will detect whether your machine is a CCE machine and make necessary adjustments to the installation process.  System administrator privileges will be needed to install AWM.

Installing AWM

AWM is available from the NRCS National Water and Climate Center

1. Download the following files from the USDA-NRCS National Water and Climate Center, Animal Waste Management webpage: www.wcc.nrcs.usda.gov/awm/awm.html  to a temporary directory on your computer’s hard drive:

· The AWM installation program,.
· The AWM database file, where # is the version number.

· AWM User Guide in MS Word (doc) or Portable Document Format (PDF).
Note: The installation files for the AWM computer program are fairly large so unless you are connected to a high speed internet connection it strongly recommended that you request the program be sent to you on CD. Please submit your request to Harbans Lal, who can be reached at (503) 273-2441 or by email at harbans.lal@por.usda.gov.
2. Execute the installation program by either:

· Double clicking on the install program in Windows Explorer, or

· Clicking Start, select Run, browse to the location of the installation file, select the install program, and click the [image: image3.png]


 button. 
Note: You must have system administrator privileges to install AWM.

3. After installing AWM, be sure to follow the instructions on the next page to install the current database, if necessary.  In this manner the most up-to-date information is used in the program.
Current Version of the AWM Database

The user can determine the current version of the AWM program and the database installed by clicking on Help->About in the AWM main menu as shown below:
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The following popup window will appear: 
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Installing the AWM Database

When AWM is installed it also installs a database containing animal, bedding, climate, and separator data for each state.  The most up-to-date database is located on the AWM website and should be downloaded, if necessary, and installed to ensure the most up-to-date data will be used in developing designs. To download the most current database for AWM, click on Help->Contents in the AWM main menu as shown below:
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The following popup window will appear:
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Click on "AWM Database" in the Contents window to access the AWM database download site as shown above.  Click on AWM Database link to download the most current version of the AWM database to the folder you select.  After downloading the file, perform the following steps to install the database file for use with the AWM program:
1. Unzip the database file by double clicking it and unzipping the file to a folder.
2. The default directory for AWM is C:\Program Files\USDA\AWM 2.3.0.

3. Replace your existing awm_data.mdb with the new file.

4. The database is now ready to be used with the program.
Starting AWM

The following instructions explain a few of the ways to start the AWM program:
Any Computer

AWM may be started by clicking on [image: image8.png]2 start
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.  This will open the program without opening any saved client files.

From Windows Explorer

A previously saved design file may be used to open AWM.  From within Windows Explorer, locate and double-click on a previously saved design file.  These files will have the extension awm (e.g., Elmer_Farms.awm)

From the Customer Service Toolkit Client List

Within the USDA Customer Service Toolkit you can browse the client list in Outlook and determine if the client files include any AWM design files.  These will be identifiable by the .awm extension.  Clicking on these files will open AWM with the previously saved design file.

From the Customer Service Toolkit 

Anytime you are working within Customer Service Toolkit on a client you may click on Tools in the menu bar, click on Engineering Tools, and select AWM.  AWM will open with the client’s name automatically entered.  Upon exiting AWM the file will be saved with the files for that client.  

Quitting AWM

From the file menu click on File then Exit,
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or press the [Alt] [F] [X] keys on the computer keyboard,

or click on the [image: image14.bmp] in the upper right-hand corner to exit AWM.  

· The previous action results in the following popup screen:
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Chapter 3 – Navigating 

Within AWM

Overview

The process of designing treatment/storage facilities using AWM involves a step-by-step sequence of screens.  When developing an initial design, the sequence of screens in the order shown on the toolbar must be followed with the exception of the calculator that can be used within any of the screens.  
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The screens and their function are as follows:

	[image: image17.png]Start




	Start -  On this screen the user defines the client, defines the designer, selects the data source (NRCS, MWPS, etc.), and sets up the operating period(s).
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	Climate -  On this screen the user defines the monthly climate parameters, the 25-year, 24-hour precipitation, and other climate-related factors.
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	Animals -  On this screen the user selects animal types and enters the number and average weights.  Animal characteristics may be modified and new animal types can be defined within this screen.
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	Locations -  On this screen the user defines locations where wastes are generated.  Wastes from different locations may have different additions to the waste stream and the wastes may be routed through different management trains.
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	Additions -  On this screen the user defines any additions to the waste streams such as from bedding, waste water, and flush water.  
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	Runoff -  On this screen the user may elect to allow AWM to calculate runoff volumes or to enter volumes calculated outside the program.
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	Management Train -  On this screen the user selects a sequence of treatment/storage components for each waste stream.
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	Design -  On this screen the user specifies the parameters used to size and calculate the dimensions of treatment/storage components.  A monthly waste stream budget is displayed on this screen.
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	Calculator -  This is a popup screen that can be used within any of the  design screens to calculate unit conversions and perform other calculations.  The calculator is not available within the ramp design screen.  The calculator must be selected from a separate button within the soil liner design screen.

	[image: image26.png]&




	Manure Master -  On this screen the user can generate a gross nutrient budget by selecting crops and entering acres and yield data.


Moving Between Screens

During the initial entry of information the user is moved from screen to screen in sequence by clicking on the [image: image27.png]


 button on each screen.

At any time the user may move to a previously completed screen by clicking on the large navigation buttons; [image: image28.png]g o\ mpa 5 wm ¥ B 2
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When a screen has been completed and the user clicks the [image: image29.png]


 button, the next navigation button will change from gray to colored.  

When a navigation button is in color;
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 it may be used to move immediately to that screen by clicking on the associated button.  

The popup calculator screen is available in any screen so it is always in color.

Any changes to information on a screen will immediately modify values on later screens if the change affects calculated values.

HELP

Help messages providing information on data entry and the operation of AWM can be accessed from the main menu or by pressing the [F1] key on the keyboard. For example:
[image: image187.png]er

Animals




[image: image188.png]er

Animals



[image: image189.png]


[image: image31.png]File Edt Data View Tools Window

§ | o |





Clicking on [image: image32.png]Contents.



 or the [F1] key reveals the following menu.
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Overview of AWM

What AWM Does

AWM a is planning/design tool for animal feeding operations that can be used to estimate the production of
manure, bedding, process water and determine the size of storagefireatment faciltes. The procedures and
caleulations used in AWM are based on the USDA-NRCS Agricultural Woaste Management Field Handbook.

AWM uses the concepts of "Manure Master® to produce a gross nufrient balance but does not track mass or
concenirafion of nufrients for determining land application rates or for other utiization components.

Features of AWM

o Provides manure characteristics for eight animal types with the abilty to modify these characteristics and
add animal types as necessary.
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Help can also be accessed on each screen by clicking on the [image: image34.png]


 button or pressing the [F1] key on the keyboard.  Help accessed in this manner gives information about the current screen.
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Entering Data into AWM 

The following provides general guidance on how to enter data into the input fields used in AWM screens:

1. Clicking on an input cell within a screen activates the edit mode.  The edit mode is indicated by the cursor blinking at the end of any value or by the text that is already in the cell.

2. Double clicking on an input cell within a screen activates the edit mode and highlights the data in the cell so that it can be replaced.

3. Using the arrow keys will exit the edit mode and move the focus rectangle to a new input cell.

4. Typing any value or text in an input cell that is not in edit mode (cursor is not blinking and is highlighted with the focus rectangle) replaces whatever data is in the cell.

5. Pressing [Enter] in an input cell causes the focus rectangle to move to the next input cell while remaining in the edit mode.

Using the above guidance for entering data into AWM input fields is demonstrated with the following example of changing the precipitation and evaporation values in the AWM Climate Screen.

1. Start AWM, select a state and then press the [image: image36.png]


 button on the Start screen,
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2. [image: image198.png]


Click in the January precipitation cell.  This action activates the edit mode, and the cursor will be blinking after the value to be edited:
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3. Highlight the value with the cursor and mouse or clear the cell by backspacing and then type in a new value followed by pressing [Enter].  This exits the edit mode and moves the focus rectangle to the February precipitation input cell.  

4. Pressing [Enter] in step 3 above allows one of two actions to be taken in the February precipitation input cell:  

a.) Type in a new value replacing whatever value is in the cell or,

b.) Press the backspace key to activate the edit mode indicated by the cursor blinking at the end of the value or text.  This allows the value in the cell to be highlighted with the mouse or use the backspace to delete the data and then type in a new value.

5. Press [Enter] to go to the next cell.  

6. Steps 4 and 5 can be repeated for each cell that requires editing.

See note next page.

Note:  An input cell is shaded red when the value in the cell is outside the range of reasonable values stored in the database.  The values stored in the database can be edited by accessing the Tools -> Options menu.  Cells shaded red is just a warning to the user that the data is outside the normal range and the data will still be used by the program for calculations. 
Although most states’ rainfall and evaporation data are in the database, some information has not been updated. The Agricultural Waste Management Field Book, Chapter 10 has rainfall data for the continental United States.  It can be downloaded at the NRCS website (http://www.info.usda.gov/CED/ftp/CED/neh651-ch10.pdf). The database for AWM will be periodically updated as information is submitted from the states.

Chapter 4 – Running AWM

	Start Screen
	[image: image39.png]Start






AWM may be started in a number of manners as explained in Chapter 2.  When AWM is opened without a specific design file it will open with the following screen.
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The illustration below shows the “New” tab selected.  This is also the default setting.
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Operating Periods

AWM has two options for defining operating periods. The screen shown on the next page will appear when the [image: image43.png]Operating Period Setup.



 button is clicked on.  Click on the radio button  [image: image44.png]1 Dperating Period



 for 1 operating period when the facility is operated the entire year without variation.  For example this option would be selected for a dairy where animals are in confinement for the entire year.  Click on the radio button [image: image45.png]% 2 Operating Periods



 for 2 operating periods when a facility operates in two distinct periods.  An example of when this option would be selected is for a dairy that keeps its animals in confinement for a part of the year and pastures the remainder.
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If “2 Operating Periods” are selected, the beginning and ending month for the first operating period must be selected.  Once this period is selected, AWM uses the remaining months for the second period.  The operating period is from the first day of the beginning month to the last day of the ending month.

Monthly precipitation and runoff for the entire year is used in the design of waste treatment/storage facilities regardless of the operating period.

To continue work on a previously saved job/design, select either the “Existing” or “Recent” tab.  Selecting the “Recent” tab will show the last ten jobs saved.  Selecting the “Existing” tab will show all the previously saved jobs in a particular directory.
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The climate screen allows the user to define the monthly precipitation and evaporation, the 25 year – 24 hour precipitation, and the anaerobic lagoon volatile solids loading rates.  There are two options for defining the climate data used within AWM.  One is to use the AWM database, which is the default option shown below, and the other is to enter custom climate data for the job.  Any input cell shaded red means the data it contains is outside the range of values stored in the data validation database.  The values in the data validation database define the range of expected values for an entry as a check for the user.  The values in the data validation database can be edited in the Tools -> Options menu.
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AWM has three options for accounting for precipitation and evaporation in the design of waste treatment/storage facilities.
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Select this option to consider evaporation only to the extent it does not exceed precipitation.  For the example shown on the previous page, AWM would set precipitation minus evaporation to 0 inches for the month of July.  
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Select this option to consider evaporation even when it will cause a deficit value for precipitation minus evaporation.  For the example shown on the previous page, AWM would set the value of precipitation minus evaporation to –4.7 inches for the month of July.
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Select this option when evaporation should be ignored.  For the example shown on the previous page, AWM would set the value of precipitation minus evaporation to be 0.7 inches for the month of July.  This may be an appropriate option for waste storage facilities and anaerobic lagoons where a crust will form that may impede evaporation.

If a state has supplied the data and requested it be provided in AWM, climate data will populate the screen when the [image: image54.png]@ Use AwM Database



 option is selected, based on the County and Station selected from the drop-down lists.  The monthly precipitation, monthly evaporation, 25-year, 24-hour precipitation, and the lagoon loading rate may all be edited by clicking on the associated input cell for the data to be changed.  Changes made in this manner will only be in effect and saved for the current job.  Permanent changes can be made by clicking on Data > Edit Climate Data on the AWM main menu as shown below.  For more on editing, see Chapter 6, “Modifying the AWM Database.” 
Although most states’ rainfall and evaporation data are in the database, some information has not been updated. The Agricultural Waste Management Field Book, Chapter 10 has rainfall data for the continental United States.  It can be downloaded at the NRCS website (http://www.info.usda.gov/CED/ftp/CED/neh651-ch10.pdf). The database for AWM will be periodically updated as information is submitted from the states.
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All of the climate data populating the climate screen is cleared, as shown below, when the [image: image56.png]@ Enter custom climate data for this job



 option is selected.  With this option the user completes all data fields manually.  The data entered in this manner will be saved with the current job and is not available for future jobs. To have climate data available for future jobs it is necessary to modify the AWM database.  Permanent changes to the climate database can be made by clicking on Data > Edit Climate Data on the AWM main menu as shown above.  For more on editing, see Chapter 6, “Modifying the AWM Database.”
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The following Animals screen appears when a new design file is being created within AWM so a user can select animal types and descriptions from the data file source selected on start screen.  AWM allows the user to select mixed animal types and descriptions.
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In most cases a single value is presented for a specific waste characteristic. This value is presented as a reasonable value for facility design and equipment selection for situations where site specific data are not available. However, waste characteristics are subject to wide variation; both greater and lesser values than those presented can be expected. Typical or average estimates of “as excreted” manure eventually become out-of-date due to changes in animal genetics, performance potential, feeding program strategies, and available feeds. Although these values are useful for long-term planning for utilization of manure and other wastes, they should not be used in determining a field specific application rate. Site specific waste sampling, testing, and data collection is essential for the utilization function of an AWMS.
Growth stage and feed rations are very important in determining manure production characteristics. For example, once a dairy calf is over 200 pounds and on a hay ration, the calf’s manure production could be better represented by a heifer’s manure production.
The following screen shows the Animals screen populated with animals selected from the AWM NRCS data file.  
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If another animal type is needed but not shown in the AWM database, click on the [image: image60.png]


 button that will result in the popup screen shown below.
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A row may be deleted from the Animals screen by selecting the row and clicking on the [image: image62.png]Delete Selected ow




 as shown on the screen below.
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The Quantity, Weight, Manure, VS, and TS may be edited by clicking on the input cell and typing in the desired value as shown on the screen below.  
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The values for an animal type appearing on the Animals screen may also be edited by double clicking on the animal type as shown on the screen below.
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Changes made by editing data within the Animals screen will only apply to the current job and is not available for future jobs. To have animal data available for future jobs it is necessary to modify the AWM database.  Permanent changes can be made by clicking on Data > Edit Animal Data on the AWM main menu as shown below.  For more on editing, see Chapter 6, “Modifying the AWM Database”.
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The purpose of the Locations screen is to define where the animals deposit their manure throughout a day for each operating period.  It also establishes a manure waste stream from a location to which waste water, flush water, and bedding are added to form the total waste stream directed to agricultural waste management system treatment/storage components such as a waste storage facility or waste treatment lagoon.   
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Once all the locations have been entered, the percent of manure deposited by each animal type in each location must be entered as shown on the screen below.  Please note this is the percent of manure and not the percent of time.  Judgement based on observation will be required for making this determination because it varies widely.  The percent manure must total 100 percent for each animal type. If two operating periods were selected on the start screen, a location table will be presented for each operating period.
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[image: image284.bmp]To delete a location first select the row by clicking on the narrow cell just to the left of the location as shown on the screen below.  This highlights the row.  Now click on the [image: image70.png]Delete Selected ow



 button.  Rows can only be selected and deleted from the first operating period table if more than one operating period was selected on the Start screen.  This action deletes the location from the table for both operating periods.
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The purpose of this screen is to characterize the amount of flush water, wastewater, and bedding added to the manure waste stream for each of the locations identified on the Locations screen.

To add additional locations where waste is generated, enter the name of the location and click 
on the [image: image72.png]


 button as shown on the screen below.
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The total wash water and flush water in gallons per day may be entered directly or by using the pop-up calculator.  The pop-up calculator screen is selected by pressing the [image: image74.bmp] button next to the Wash Water or Flush Water input cell as shown on the screen above.

The calculator pop-up screen for wash water follows:
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The calculator pop-up screen for flush water follows:
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Take care to indicate a flush volume for only those animals identified as spending time at the location on the Locations screen.  Also please note that if recycled water is used for flushing, values entered should only be to the extent that fresh non-recycled water is added to the system.

Clicking on the [image: image77.png]v SaveData



 check box will save the data in the Wash Water and Flush Water calculator for the current design session of AWM. All values entered into the Wash Water and Flush Water calculator will be lost once the AWM design session is closed.

The purpose of this screen is to characterize the types and amount of bedding used per day for each waste stream for each of the locations identified on the Locations screen. 
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Bedding Type – Select the bedding type from the drop-down list.  The default bedding types included in AWM are shown below.  Additional bedding types may be entered by choosing “Data / Edit Bedding Data” from the AWM main menu.
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Eff Density -- The volume occupied by bedding in a manure storage facility is reduced to account for the manure filling the void space in the bedding over time.  This is accounted for by AWM using the “effective bedding density” in the Bedding Data table.  Effective density is affected by management style, such as the amount of time between cleanouts.  The default values can be changed by the user by overwriting the displayed values.  Eff Density values can be reset to the default values in the Bedding Data table by clicking the Reset Effective Densities button.
Amount -- Click on the input cell for the bedding selected and enter the amount of bedding added in pounds per day.  If bedding is not added every day, the amount used should be converted to an equivalent pounds per day.  If the producer knows the amount of bedding used by volume rather than by weight, then use the LV Amt field to help you convert volume to weight.  See the example below.

LV Amt -- For reference, the volume (cu ft/day) of loose bedding added is displayed, based upon the density of the bedding set in Bedding Data table and the amount of bedding added (lbs/day).

Use this field to assist in converting bedding amounts known by volume into amounts by weight.  For example, if a producer knows that 6 cords of sawdust/shavings are used per month, then this will convert to (6 cords x 128 ft3/cord) / 30 days = 25.6 ft3 per day.  Then, using trial and error, enter amounts of bedding by weight until the known volume is displayed in the LV Amt column (a value of 270 lb/day is equivalent to 25.7 ft3/day).

CV Amt -- For reference, the volume (cu ft/day) of compacted bedding is displayed, based upon the effective density of the bedding set in Bedding Data table and the amount of bedding added (lbs/day).  The compacted volume is the amount of bedding that will be used by AWM to size the receiving facility.

The loose and effective densities of bedding can be modified by accessing the “Data / Edit Bedding Data” from the AWM main menu.  For more on editing the AWM databases, see Chapter 6, “Modifying the AWM Databases”.
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The Runoff screen estimates the contaminated runoff that must be managed by the waste management system.  Runoff volumes estimated by AWM are conservative overestimates.  Because of this, the user is encouraged to use a method outside the program to determine the monthly and the 25-year, 24-hour runoff volumes, especially when larger watersheds are involved.

AWM computes runoff for two types of “watersheds:”

· impervious “watersheds” such as roofs and frequently scraped concrete slabs; and

· pervious watersheds including feedlots with a manure pack..

The runoff volume from only one drainage area for each type of watershed is computed.  If a system design requires evaluation of more than one drainage area in one or both types of watersheds, the runoff volumes will need to be computed outside the program and entered as demonstrated below.

Impervious watershed runoff is computed based on a Curve Number of 98 and a user input impervious area in square feet.  AWM does not allow the Curve Number for this watershed type to be changed.  If a different Curve Number is desired, the AWM computation should be made using the pervious watershed category or by using a method outside the program.

Pervious watershed runoff is computed on the basis of a user-input Curve Number and watershed area in acres.  Feedlots having a manure pack should use this method.  The user can enter a 1 day curve number and click the [image: image81.bmp] (1-day) radio button and the program will convert the 1 day curve entered to a 30 day curve number. The 30 day curve number computed from the 1 day curve number may be viewed by passing the mouse pointer over the [image: image82.bmp] (1-day) radio button.  If the user enters a 30 day curve number and clicks on the [image: image83.bmp] (30-day) radio button, the program will use the curve number as entered to compute the runoff volumes.

AWM computes runoff by first converting the 1-day Curve Number to a 30-day Curve Number using the following equation:

CN30 = CN1 – (CN1 – ((CN1^2.365)/631.79)  -  15) log 30

The equations of the EFH Handbook Chapter 2 revised for a 30 day CN would be:

S = (1000 / CN30) – 10                  (Rearranged Equation 2-4)

Q = ((P – 0.2S)^2 / (P + 0.8S))       (Equation 2-3)

Where:      Q = runoff in inches

             P = rainfall in inches

             S = potential maximum retention after runoff begins in inches

The following illustrates the Runoff screen when [image: image84.png](+ Calculate Monthly Runoff Yolumes



 radio button is selected.
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The program will compute the runoff volumes based on the precipitation data and runoff curve numbers entered on the Climate screen.

Runoff volumes based on calculations made outside the program may be entered directly into the runoff table.  To enter runoff volumes directly, select the  [image: image86.png]@ Enter Monthly Runoff Yolumes



 button as shown below.
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The purpose of the Management Train screen is to define the sequence of management components, as described within AWM, for each waste stream developed by the program in the Locations and Additions screens.  The sequence of components is described in AWM as management “steps.”  AWM is capable of evaluating up to three management steps or components for each waste stream.  Solid-liquid separator components split a waste stream into two waste streams – solids and liquids.  Each of these new waste streams must be followed by appropriate storage components.  An uncovered stacking facility requires a liquid storage component, either a pond or a tank, be specified in the next step to store runoff.  An anaerobic lagoon with external storage requires that a liquid storage component, either a pond or a tank, be specified in the next step.  Multiple waste streams may be directed to a single management component

The following is a blank Management Train screen for a dairy as it would appear when AWM is run for a new waste management system design.  The waste stream column lists the waste streams from (1) locations defined on the Locations screen, (2) any user-defined waste streams, and (3) runoff.  Clicking on an input cell will access a drop-down list of available components as illustrated on the screen below.
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A storage pond, storage tank, covered dry stack, or anaerobic lagoon can be a terminal component in the waste management train.  However, a solid-liquid separator, uncovered dry stack, and anaerobic lagoon with external storage all require an appropriate subsequent liquid storage component.

The first time the component drop-down list is accessed, all of the available components will be identified as “new”.  Once a component is selected for a management step, it will appear on subsequent drop-down lists and is available for use in other waste stream management steps.  For example, if “New Storage Pond” is selected for one management step, the next time the drop-down list is accessed this pond will appear as “Storage Pond #1”.  This pond could then be selected for another waste stream.  However, if a second storage pond is desired, “New Storage Pond” would be selected.  Subsequent access to drop-down list would identify this pond as “Storage Pond #2.”

When the “Solid-Liquid Separator” component is selected, another drop-down list is accessed that gives a list of separator types.
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The next step after solid-liquid separation must define the components to which both the solids and liquids will be directed as shown below.
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When an uncovered dry stack is selected, an appropriate liquid storage component must be selected in the next step to store its runoff as shown on the screen below.
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When an anaerobic lagoon with external storage is selected in the management train, it must be followed in the next step with an external storage component as illustrated below:
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Component Volumes (cu. ft/day) - the relative volumes of materials stored within the different structures. The solids portion of manure removed by the use of a solids separator is not subtracted from the solids storage volume of a storage pond or lagoon. Therefore, the size of the lagoon or storage pond is NOT reduced due to the use of a solids separator. 

The Design screen will reveal tabs for each of the storage or treatment facility components, except solid-liquid separation facilities, that were selected on the Management Train screen as shown below.  
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Dry Stack Design Screen (Covered and Uncovered)

The AWM design of dry stacks is the same for both uncovered and covered stacks with the exception that the precipitation falling on an uncovered dry stack is directed to an anaerobic lagoon, waste storage pond or tank. Therefore, from a sizing standpoint, both covered and uncovered design screens are the same. Even though the design screen for a covered dry stack is illustrated, it applies to uncovered as well.

Option 1.  Simple four-sided stacking structure
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To design a dry stack facility the following entries are needed on the dry stack design screen in AWM:

Storage Depth – Click on the input cell and enter the value for the preferred depth in feet (not including freeboard) for the dry stack facility.

Input Dimension – Click on the drop-down list box and select the dimension, bottom width or bottom length, on which to base the dry stack design.

Bottom Width, Length – Click on the input cell and enter the value in feet for the dimension selected to base the design on, bottom width or bottom length.

Freeboard – Click on the input cell and enter the value for the preferred freeboard in feet for the dry stack facility.  NRCS does not require a minimum freeboard value for dry stack facilities but regulatory agencies may require a minimum freeboard value.

Max. Storage Volume Method – To select the way AWM computes the maximum storage volume needed in the dry stack facility click on the [image: image96.jpg]


radio button associated with the preferred method. 

For the [image: image97.jpg]i+ Define Withdrawal Months



 method the user needs to click on the check boxes associated with the months when the dry stack facility will be emptied.  When a withdrawal month is checked, AWM assumes the dry stack facility will be empty at the end of the months selected.  
 For the [image: image98.jpg](¢ Define Storage Period



 method the user needs to select the number of months from the drop-down list or input the number of months of storage preferred.  For a dry stack facility design AWM determines which month or group of consecutive months during the year for the storage period specified requires the greatest storage volume and sizes the facility accordingly.  The critical months for design are displayed in the cross section area of the design screen.  To design for less than 1 month of storage select "1" for the months of storage and another drop-down list will appear where you may select the number of days of storage.
AWM will compute the required dimensions of the facility based on the entered values. 

Note:  The dimensions at the top of the screen will also include the computed top width and top length of the stack.  If the combination of side slope, stack height and bottom length or width causes the top width or length to become negative, the program will display the following message in the status bar:

[image: image99.jpg]Cross Section

If a combination of height, width, length and side

slope generates a negative Top dimension, then this
error message will appear at the bottom of the screen.
Modify the dimensions to eliminate the error.





If this warning message is displayed, modify the input values depth (D), sideslope (Z), bottom width (W) or length (L) to properly size the facility and eliminate the warning message.

Option 2 – Setting the Wall Height for a Dry Stack Facility
AWM provides an option on the design screen to set the wall height and stack height for a dry stack facility.  The following inputs are needed when the [image: image100.jpg]v Setwal Height



check box is selected on the design screen for a dry stack facility:

Wall Height – Click on the input cell and enter the value for the preferred wall height for the dry stack facility.  Note that if zero is entered for the wall height the program assumes a slab is being sized for a dry stack facility. 

Storage Depth – Enter the depth that the material will be stacked.  This value may be higher than the wall height.
Input Dimension – Click on the drop-down list box and select the dimension, bottom width or bottom length, on which to base the dry stack design.

Bottom Width, Length – Click on the input cell and enter the value in feet for the dimension selected to base the design on, bottom width or bottom length.

Freeboard – Enter the value for the preferred freeboard in feet.  Note that this dimension will set the assumed maximum height that the material will be stacked against the walls.  In the example shown above, the assumed depth of material will be stacked 3.5 feet against the walls and 6 feet total in the center.  

Note the difference in the definition of freeboard between options 1 and 2.  In option 1, the freeboard is added to the storage depth to compute the total wall height.  In option 2, the wall height is set by the user, so the freeboard determines the height that the material is stacked against the wall.
Side Slope – Click on the input cell and enter the value for the assumed slope of the stacked material within the facility.  The side slope entered is considered to be uniform on all four sides of the stack.
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Max. Storage Volume Method – To select the way AWM computes the maximum storage volume needed in the dry stack facility click on the [image: image102.jpg]


radio button associated with the preferred method. 

For the [image: image103.jpg]i+ Define Withdrawal Months



 method the user needs to click on the check boxes associated with the months when the dry stack facility will be emptied.  When a withdrawal month is checked, AWM assumes the dry stack facility will be empty at the end of the months selected.  To design for less than 1 month of storage, select all the months and another drop-down list will appear where you may select the number of days of storage, as shown above in Option 1. 

For the [image: image104.jpg](¢ Define Storage Period



 method the user needs to select the number of months from the drop-down list or input the number of months of storage preferred.  For a dry stack facility design AWM determines which month or group of consecutive months during the year for the storage period specified requires the greatest storage volume and sizes the facility accordingly.  The critical months for design are displayed in the cross section area of the design screen.  To design for less than 1 month of storage select "1" for the months of storage and another drop-down list will appear where you may select the number of days of storage, as shown above in Option 1.
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AWM will compute the required dimensions of the facility based on the entered values. 

Note:  The dimensions at the top of the screen will also include the computed top width and top length of the stack.  If the combination of side slope, stack height and bottom length or width causes the top width or length to become negative, the program will display the following message in the status bar:
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If this warning message is displayed, modify the input values depth (D), sideslope (Z), bottom width (W) or length (L) to properly size the facility and eliminate the warning message.

Option 3 – Pad Design
You can size a pad to stack material by checking the box for “Set Wall Height”, then entering zero for the wall height.

Enter the depth of storage, the bottom width or length, and the assumed side slope of the stacked material.  Then, define the storage volume method and enter the length of storage as described above in option 1.  An example of a pad design is shown in the following figure.
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Storage Pond Design 

The design of storage ponds in AWM allows the user to define a rectangular or circle type pond. AWM bases the design on the storage depth, bottom width or length, permanent additional storage, freeboard, sideslope ratio and maximum storage volume method inputs made by the user.

The following screen illustrates a rectangular storage pond design based on defining withdrawal months:

[image: image108.png]“a Design Waste Storage Structures

Stoage Pand o1 |

Joput Dt Cros Section
e Foctnge ]| | ChoaMie Ot BaW s IS0 TeoWaLeZ00RZT
DT
oo
Total Depth ® I Include Sai Liner I Include Ramp.
e R oo wiot: ]
Bottom Width 150.0 it }47 TL=27111 — -
PemenertAddl [g ot T recbowra= 1010 —
s N oemamvon st 7
T oo woen oo J)
Stsperioin \ P /
b-100n
T
Max. Storage Volume Method :u!\ ml: ‘normal runoff, and extemal = 221302 CF 5771
@ Define Withdrawal Months lorage (ifany)
Dot St Pt
e e s

fe—— BL-21man —

Water Budget (1000 cu f)

dan | Feb | Mar | Apr | May | Jun | Jul | Aug | Sep | Oct | Nov | Dec | Total

Withdrawal Dates [ | O | O ol|lo|o|o ol|o|o
Waste F20| 013 783|744 769] 7a4|  7es| 7es| 74| 769] 3116 3220 T6ds
Runoff a3 89| 764 aes| 243) 12| OM| 025 75| 4%| 1444] 1a13] 78
PrecEvap 2756 173 133| 39| a0 72| 1597 1a1s| az8| @es| 2583 3210)
Cum. Storage Vol | 25001] 30696 3%62] %074| 711 881|083 000 691 213 28| 17531

Stage Storags Curve Help K.







For a storage pond design is based on a storage period or withdrawal months, AWM determines which set of consecutive months during the year requires the greatest storage volume and sizes the facility using the user’s decision on Total Depth of the structure.
The following screen illustrates a circular storage pond design based on defining a storage period:
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Storage depth is the Total Depth of the pond, as selected by the user, less freeboard, depth of 25-yr., 24-hr. precipitation, depth of 25-yr., 24-hr. storm event runoff, and depth of precipitation less evaporation option selected on the Climate screen.  Permanent additional Storage may be required to meet management goals or regulatory requirements (see NRCS Practice Standard 313, Waste Storage Facility).

The following screen illustrates the soil liner design option for a storage pond:
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The liquid depth AWM uses for designing the soil liner is based on the total depth of the pond less freeboard, depth of 25-yr., 24-hr. precipitation, and the depth of the 25-yr., 24-hr. storm event runoff. NOTE: this will increase the total depth shown on the schismatic.
The following screen illustrates the parallel ramp design option for a storage pond:
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Note: The parallel ramp design screen is not available for circular ponds.

The following screen illustrates the perpendicular ramp design option for a storage pond:
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Note: The perpendicular ramp design screen is not available for circular ponds.
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The following screen illustrates the stage-storage curve for the example storage pond design:
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A stage-storage curve defines the relationship between the depth of liquid and the storage volume available within a structure.

Volume Stored: measured from the bottom of the structure, how much liquid has been stored or how much more liquid can be stored. 

Volume Remaining: measured from the top of the structure, how much liquid remains after pumping, or how much liquid can be pumped.

Storage Tank Design

The design of tanks in AWM allows the user to define a rectangular or circular type tank. AWM bases the design on the storage depth, bottom width or length, permanent additional storage, freeboard, precipitation excluded or not and maximum storage volume method inputs made by the user.

The following screen illustrates a rectangular tank design based on defining withdrawal months:
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For a tank design based on a storage period, AWM determines which set of consecutive months during the year for the storage period specified requires the greatest storage volume and sizes the facility accordingly.

The following screen illustrates a circular tank design based on defining a storage period and excluding precipitation:
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Storage depth for covered tanks excludes depth of 25-yr., 24-hr. precipitation and depth of precipitation less evaporation option selected on the Climate screen.  Permanent additional Storage may be required to meet management goals or regulatory requirements (see NRCS Practice Standard 313, Waste Storage Facility).  Passing the mouse pointer over [image: image117.png]Permanent Add!
Storage:



 will generate a popup box that shows the cubic feet of storage associated with the depth of additional storage entered.

The following screen illustrates the parallel ramp design option for a rectangular tank:
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The parallel ramp design screen is not available for circular tanks.

The following screen illustrates the perpendicular ramp design option for a rectangular tank:
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The perpendicular ramp design screen is not available for circular tanks.

Anaerobic Lagoon Design 

The inputs for the design of anaerobic lagoons in AWM are very similar to the design of a storage pond.  AWM allows the user to define a rectangular or circular type lagoon. AWM bases the design on the storage depth, bottom width or length, permanent additional storage, freeboard, sideslope ratio, sludge accumulation period and maximum storage volume method inputs made by the user.

The following screen illustrates a rectangular anaerobic lagoon design based on defining withdrawal months:
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For an anaerobic lagoon design based on a storage period, AWM determines which set of consecutive months during the year for the storage period specified requires the greatest storage volume and sizes the facility accordingly.

The following screen illustrates a circular anaerobic lagoon design based on defining a storage period and using the Rational Design Method:
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Permanent additional Storage may be required to meet management goals or regulatory requirements (see NRCS Practice Standard 359, Waste Treatment Lagoon).  At least 1 year of sludge accumulation period should be entered to account for sludge buildup in the lagoon.

The following screen illustrates the soil liner design option for an anaerobic lagoon:
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The liquid depth AWM uses for designing the soil liner is based on the total depth of the lagoon less freeboard, depth of 25-yr., 24-hr. precipitation, and the depth of the 25-yr., 24-hr. storm event runoff. NOTE: this will increase the total depth shown on the schismatic.
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The following screen illustrates the stage-storage curve for the example anaerobic lagoon design:
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A stage-storage curve defines the relationship between the depth of liquid and the storage volume available within a structure.

Volume Stored: measured from the bottom of the structure, how much liquid has been stored or how much more liquid can be stored. 
Volume Remaining: measured from the top of the structure, how much liquid remains after pumping, or how much liquid can be pumped.

Anaerobic Lagoon with External Storage 

The anaerobic lagoon with external storage design option utilizes an anaerobic lagoon to contain the minimum treatment volume.  All other volume requirements are contained in the storage facility that must follow the lagoon in the management train.  The only time this lagoon would be emptied would be for sludge removal.

The following screen illustrates a rectangular anaerobic lagoon with external storage design:
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The following screen illustrates a circular anaerobic lagoon with external storage design based on using the Rational Design Method:
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Storage depth is the total depth of the lagoon less freeboard.  Since lagoons with external storage do not provide storage, an additional storage component must follow this type of facility in the management train.  

The following screen illustrates the soil liner design option for an anaerobic lagoon with external storage:
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The liquid depth AWM uses for designing the soil liner is based on the total depth of the lagoon less freeboard. 

The Conversion Calculator is available within all screens in AWM and is activated by clicking on the Calculator button on the AWM tool bar or selecting the Unit Conversion Calculator from the Tools drop-down menu. The calculator can be used to perform mathematical calculations but is provided primarily for unit conversion. Select the To and From units in the combo boxes, type in the number to be converted and press the Convert button.

The following screen illustrates how the Calculator can be used to convert units:
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The following screen illustrates the results of the conversion of 2 acres to square feet:
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The user should have a good understanding of the data format before attempting to edit or add data to the Conversion Calculator database.

Manure Master is a simple screening tool that can help assess the relative potential for the nutrients contained in the animal manure from an animal feeding operation to meet the crop uptake and utilization requirements for those crops that receive applications of manure.  Manure Master calculates a balance between the nitrogen, phosphorus, and potassium content in the manure and the quantity of these nutrients used by crops. This balance can be calculated based upon recommended fertilizer application rates, when known or upon estimated plant nutrient content, when recommended fertilizer application rates are not known.  For nitrogen, the balance is calculated taking into account expected losses from leaching, denitrification, and volatilization. Manure Master is not a nutrient management planning tool, therefore criteria in the NRCS Practice Standard 590, Nutrient Management, should be referenced when developing nutrient management plans.

The following screens illustrate the use of Manure Master:
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The following screen illustrates output from Manure Master based on the previous screen:
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The following screen illustrates options for Manure Master output:
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Chapter 5 – Reports

AWM generates several different report formats to document the system design. The reports are generated from File->Reports on the main AWM menu as shown below:
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Previewing and Printing a Report

Selecting the Preview Report results in the following screen for the example design:
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Selecting the Animal Waste Management Plan report to preview results in the following screen for the example design:
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Clicking on the button will produce the following results:
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The AWM program uses Microsoft Access to preview and print a report.  Using the export tools within Microsoft Access the user can export a report to a Microsoft Word or Excel file so it can be formatted and saved by the user.  The only limitation to creating custom reports for use in the AWM program is the user’s knowledge level on how to create and edit reports using Microsoft Access.

To print a report, select the Print Reports from the Reports menu as shown on the following screen:
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Selecting the Print Reports results in the following screen for the example design:

[image: image140.png]7 Show Subrepots ¥ Show AllStaes.

AwDesignimageDutput
AwsubAdditonsData
AwsubArimaData
AwsubCimateData
AwsubDesigrFaciiData
AwsubDesigriwteBudgelData
AwsubLocatiorData
AwsubRunofiData
AwsubRunDfPervimpenData
AwsubTrain acityolmeData
AwsubTrainStepData

MD Recepton Tark

OH Anasrobic Lagoon Data

OH Anasrobic Lagoon D&M

OH MM Input Data

OH Stacking Faciity Data

OH Stacking Facilty D&M

OH Storage Pond Data =
OH Storage Pond D3
OH Tark Data

OH Tark D8

3

Cancel | | Bt





AWM MMP Input Report 
This report can be used to manually transfer data to the Purdue Manure Management Planner (MMP) program. The NRCS Animal Waste Management (AWM) program is used to analyze the capacity of an existing manure storage facility or to size a new facility.  The design inputs for the AWM are:

· Number & type of livestock (has option of manure production tables)

· Bedding (uses table of effective density for bedding types)

· Wastewater 

· Surface area of contributing runoff (calculates monthly rainfall volume based on county rainfall tables)

In addition the AWM calculates the volume of runoff & rainfall resulting from a 24 hr- 25 yr frequency storm.

The MMP program is used to determine nutrient allocations for fields receiving manure.  The design inputs to determine manure production volume are:

· Number & type of livestock (can share a common table with the AWM)

· Bedding

· Wastewater 

By default the MMP estimates the rainfall volume appropriate for the type of storage facility and calculates “estimated manure production” as displayed in the “analysis” tab.  From this estimated total manure volume the MMP then displays nutrient concentrations on the analysis tab.

In the “storage tab” the MMP has a calculator that can be used to determine the volume of an existing storage facility.  The MMP then uses the storage volume, manure production volumes, and manure application schedule in a mass balance to develop the nutrient management plan. 

The differences in the AWM and MMP become apparent with the design of a manure storage facility that is subject to runoff inputs.  This is because the MMP estimates the runoff and rainfall entering a storage facility.  Thus, the most accurate assessment of a storage pumpable capacity and measured annual production volume is when the AWM is used to calculate the total annual production and storage capacity, and generate a report with the data by the AWM to be inputted into the MMP.  These are the steps:

· Run the AWM to determine the storage volume of an existing facility or to size a planned facility.  

· Once the size of the facility(s) is (are) determined; open and print the “AWM MMP input” report from the “file”, “report”, “preview report” tab in the AWM.  This report shows: 

· Annual manure production linked to each manure storage facility (excludes volume from the 25-yr storm)

· Design Storage capacity of each facility (excludes volume from the 25-yr storm)

· Annual raw manure production volume from livestock (this data is shown for comparison to raw manure data displayed in the MMP so the user can verify the selected manure source table) 

· Open the “Animals” tab in the MMP. Populate the columns with the same animals used to run the AWM; however, do not populate the “extra water” and “bedding” columns.  The MMP will use this data to estimate manure production and nutrient concentrations and display the data in the “Analysis tab”.

· Open the MMP “Storage tab”.  Populate each column with the same “storage ID” and “Storage type” from the “AWM MMP input” report.  Then enter the “Spreadable or Pumpable capacity” for each identified storage facility.

· Open the MMP “Analysis tab” and enter the “Measured Manure Production” volume from the “AWM MMP input” report into the MMP “Measured Manure Production” column.  Note that the MMP will then recalculate nutrient concentrations based upon raw manure data, measured manure production, and default value storage nutrient loss.

· Continue running the MMP as usual.  The program will now more accurately be able to balance manure production & storage to manure removed for land application.         
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MMP Input Data from AWM for:
700 dairy - 1 pond
Assisted by:
MJM
Measured Annual Manure Production (for MMP "Analysis" tab)

 Annual Throughput 








Volume w/o 25Yr 

Facility
Manure
Bedding
Wash Water
Flush Water
Runoff
Rainfall
Rainfall and Runoff

Tons
Gallons
Tons
Gallons
Gallons
Gallons
Gallons
Gallons
Tons
Gallons
Storage Pond 
NA
4560970
NA
504088
2818000
0
842098
840680
NA
9565836
#1
Annual Total
0
4,560,970
0
504,088
2,818,000
0
842,098
840,680
0
9,565,836

Spreadable or Pumpable Capacity (for MMP "Storage" tab)
 Design Volume w/o 








Design Storage 
25Yr Rainfall and 

Facility
Manure
Bedding
Wash Water
Flush Water
Runoff
Rainfall
Period
Runoff

Tons
Gallons
Tons
Gallons
Gallons
Gallons
Gallons
Gallons
Months
Tons
Gallons

Storage Pond 
NA
4560970
NA
504088
2818000
0
842098
840680
12
NA
9565836

#1

Animal Production Data
Manure Produced

 per Animal Unit 
Total Manure 

in CF/Day
Produced in 
Annual Manure 
Annual Manure 

Animal
Type of Animal
Number
Weight in Lb
CF/Day
Produced in CF
Produced in Gal

Lactating Cow
Dairy
700
1400
1.70
1666.00
609,756
4,560,975

Totals
700
N/A
N/A
1666.00
609,756
4,560,975

Determining storage volume of an existing facility

This is a trial and error process;

1. First input animals, bedding, wastewater and any other production inputs as they exist.

2. Designate the storage type in the Mgmt Train screen

3. Size the storage to match the existing component dimensions.  Field inventory work or as-built construction drawings will be needed.

If the storage dimensions can NOT be matched with the current production inputs then use the production information to obtain the Measured Annual Production volume needed for MMP (Analysis Tab).  

Trial 2 for sizing an existing storage component;

1. From the previous information clear out all the bedding, wastewater and any other production inputs to zero, while maintaining a storage period of at least 6-months.  Keep the animal input information to work from.  In the design screen click on the Animals screen so you can view both screens at the same time.
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2. Now manipulate the number of animals in the animal screen to obtain the existing storage dimensions. As you change the animal numbers the storage dimensions will change in the design screen.  For this example the storage pond is 10 ft deep, 3:1 sideslopes, 100ft x 200ft top dimensions.  Through trial and error by changing the animal numbers you can get within .3ft of a foot to the actual storage dimensions of the existing structure.
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3. Once you obtain the existing storage dimensions then run the AWM MMP Input Report to obtain the Spreadable or Pumpable Capacity (for MMP “Storage” tab), or you can run the AWM Storage Pond Data report to obtain the same information.  Keep in mind that the production volumes are incorrect and through trial and error we are obtaining only the storage capacity information.  

4. The use of AWM through this method of sizing an existing storage facility is limited to the conventional storage shapes within AWM.  Other software such as AutoCAD maybe better utilized for none conventional storage shapes in estimating storage capacities of existing facilities.
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Exporting a Report

To export a report to a Microsoft Word rich text format (RTF) file, select the Export Reports from the Reports menu as shown on the following screen:

[image: image149.png]ctivo

Export Reparts





Selecting the Export Reports results in the following screen for the example design:
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Clicking on the [image: image151.png]Export 1o Fiels)



 button results in the following screen for the example design:
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Clicking on the [image: image153.png]


 button results in the following screen for the example design:

[image: image154.png]2 Animal Waste Management Plan. rif, - Microsoft Word

Ble Edt Vew Iwet Fomat ook Table Window Help AdobsPDF  Acrobat Comments

a8 Ry alo- T % - ? TimesNewRoman - 12 v B
. FinalShoningMarkup  ~ Show | € B B~ K+ {3~ B . M A=

R RN

Animal Wt Wamagenent Pian
propwet

<
Draw~ [} Autoshapes- N\ W [ O E 4l 5 @ - L-A-=

Page 2 Sec 1 24 A0S Ini Col2





Use the features of the selected program to edit and save the custom report.
Chapter 6 – Modifying the AWM Database

The AWM database has four tables, all of which can all be modified.  They are:

· Climate

· Animals

· Bedding

· Separators

Note:  Changes made to the database do not take affect until AWM is exited and then restarted.

The tables within the AWM database are accessed from the main AWM menu by first clicking on Data and then clicking on the table to be modified as illustrated in the following screen:
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If AWM is being used for the first time, the database may not be the most up-to-date database available. Refer to Chapter 2, Installing and Starting AWM for instructions on how to download the current database from the NRCS National Water and Climate Center webpage.

Editing Climate Data

There are several ways that climate data can be edited or added to the climate data table.  Each method is described in the following instructions.
To edit existing climatic data, select the Data -> Edit Climate Data and the following screen will appear: 
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The following screen illustrates how to add a climate station to the climate database:
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After completing data entry for new climate stations, close the Edit Climate Data screen by clicking on the [image: image159.bmp] in the upper right hand corner of the screen.  After exiting and restarting AWM, the new climate station will have been positioned in alphabetical order by state, county, and climate station. 

Importing Climate Data

You can import climate data from a file that is in comma delimited format.  The file must have all of the fields in the same order as they appear in the climate data table.  The file should not have a header row and should have one climate station per line.  The file can have as many lines as desired.  When importing data, if a value already exists in the table, a dialog box will popup and ask if it is OK replace the value that is in the database.

There are several ways to build a data file for import into AWM.  One way is to use Microsoft Word to develop the data and then save it as a text file(.txt).  Another way is to use Microsoft Excel to develop the data and then save it as a comma delimited file(.csv).  The order of data is State, County, Station, 25-year 24-hour precipitation, January precipitation, February precipitation, March precipitation, April precipitation, May precipitation, June precipitation, July precipitation, August precipitation, September precipitation, October precipitation, November precipitation, December precipitation, January evaporation, February evaporation, March evaporation, April evaporation, May evaporation, June evaporation, July evaporation, August evaporation, September evaporation, October evaporation, November evaporation, December evaporation, Barth’s Kval, anaerobic lagoon volatile solids loading rate, volatile solids loading rate for odors and Rational Method maximum anaerobic lagoon volatile solids loading rate.  

An example of one line of climatic data follows:

OR, East, New, 4.00, 6.90, 4.79, 4.33, 2.29, 2.09, 1.39, 0.35, 0.57, 1.46, 3.98, 6.08, 6.85, 0.26, 0.52, 1.04, 1.82, 3.12, 3.90, 5.72, 4.68, 2.86, 1.30, 0.52, 0.26, 0.60, 5.25, 0.0038,0.00625

Each line of the file should have 34 pieces of data separated by commas.  The import will fail if this convention is not precisely followed.  A space after the commas may be included or not used.

The following demonstrates saving the above line of data entered into Microsoft Word as a text file:
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From the Microsoft Word main menu click on File -> Save As and the following window will appear:

 [image: image161.png]Save

o

My Documents

My Network.
Places.

55 User Guide - B @ ¥ CiE - Todks~

Flename:  [iew bt

Save astype: [plan Text (%) =




The following demonstrates saving the above line of data entered into Microsoft Excel as a comma delimited text file:
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From the Microsoft Excel main menu click on File -> Save As and the following window will appear:
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The following demonstrates importing a climate data .csv file into the AWM database:
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This action results in the following screen:
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The following dialogue box will appear if the file was successfully imported:
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The imported file will appear as the first line for the State in the climate data table.  After exiting and restarting AWM, the records will be resorted into alphabetical order by state, county and weather station.

A climate file developed in Microsoft Word can also be imported using the same procedure described for a text file but instead of selecting a [image: image167.png]CSY (Comma delimited) (*.csv)



 file type you select  [image: image168.png]Text Only (*.bxt)



 file type.

Deleting Climate Data

The following demonstrates how to delete a line of climate station data from the climate data table:
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Editing the Animal Data

The animal data table can be edited two ways.  One way is to edit data that already exist in the table and the other is to add data.  The animal table does not have an import feature.

The following screen illustrates how to edit data in the animal data table:
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The following screen illustrates how to delete a animal from the animal data table:
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The following screen illustrates how to add animal data to the animal data table:
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The added animal is placed on the first line in the data table.  The following screen illustrates an animal named “New Cow” added using the procedure above.  Animal data for the “New Cow” is added by clicking on the appropriate input cell and entering the data.
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After quitting and restarting the program, the new animal added will be sorted into alphabetical order by Name and Data Source.

Animals added that are lactating are indicated with a one (1) in the “Is Lactating” column.  This is to associate the animal with a flush water volume indicated in the “Flush Water Vol” column in the Flush Water Calculator on the Additions Screen.

Editing the Bedding Data

Editing the bedding data table is very similar to editing the animal data table.  Data may be edited within the data table or new bedding data can be added or existing bedding data deleted.  The following screen illustrates how to add bedding data called “New Bedding”:
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The following screen illustrates how to edit existing bedding data:
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The following screen demonstrates deleting bedding material from the bedding data table:
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Editing the Separator Data

The separator data table contains efficiency values for liquid/solid separators by the type of separator.  Data may be edited within the data table, a new separator can be added, or an existing separator can be deleted.  Adding a separator called “New Separator” is demonstrated on the following screen:
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Editing the efficiency value for a separator in the data table is illustrated on the following screen:
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Deleting a line of separator data is illustrated on the following screen:
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Type in landowner’s name.





Type in your name.





Click here to access the Data Source drop-down list and then select the preferred animal data source. 





Select “Recent” tab for a list of the last 10 jobs that were loaded when the user exited AWM.





Click on the desired file and click the � button to load the stored data into the AWM program from the selected file.





Click the � button when done editing the Animals Screen.





“2 Operating Periods” are selected.





Click here to access the Beginning Month drop-down list and click on the beginning month of first operating period.





Click here to access the Ending Month drop-down list and click on the ending month of first operating period.





Click on the animal cell to select the row to be deleted.





Type in the name of a location where animals spend time.





Animals may be added at any time by clicking on the � Button.





Click the � button to add all animal choices in the choices list window.





Enter the quantity and average weight in pounds for each animal selected.





Click the � button to remove all animals from the selected list window. 





Click the � button when done.





Click the � button to remove highlighted animals from the selected list window. 





Enter the name of the animal type being added


Click on the drop-down list to select the animal type being added.


Enter the manure volume, volatile solids, total solids, sludge accumulation ratio, and flush water as appropriate.


Enter the pounds per ton of Nitrogen, Phosphorous, and Potassium that will be generated by the animal being added after all losses are accounted for. 


Click on this box if animal type involves lactating cows.  This associates the new animal with a flush water volume per animal.








Click on the � button or press the [Delete] key on the keyboard to delete the selected row.





For any of the selected animals, click on the desired input cell to edit the displayed data.





Enter the percent of manure each animal type deposits in each location.











Click the � button when done.





After typing in the name of the location, click the � button or press the [Enter] key.








Click on the � button to access the Wash Water and Flush Water calculator








Type in the name of additional waste streams.  These will appear in the table in italics after clicking on the � button.





The additional waste stream entered is shown in italics.





Enter the amount that applies to the operation in gallons per unit that is appropriate for each Source or Hose.





Type in the washes or minutes per day for each operation where an amount was entered for a Source or Hose.





Checking this box means the last data entering into the Wash Water screen will be saved and displayed the next time the screen is accessed.





Clicking in the input cell for Step 3, in the example shown on the screen below, accesses a drop-down list of storage components that can be selected to store effluent from the anaerobic lagoon.





Select type of  separator. 





Enter 25-year, 24-hour storm volume as determined by a method outside AWM





Click on the �  radio button.





Enter the impervious watershed area.








Click on the �  radio button.





Type in the pervious watershed area and the 1-day runoff curve number for the 25Yr-24Hr storm rainfall and the 1-day or 30-day runoff curve number.





Type in impervious area.





Enter monthly runoff as determined by a method outside AWM.








“New” tab selected.





Click on the � button if the farm has more than one operating period.





Click within the input cell to access the drop-down list of available components.





Click on desired component for Step 1 of the waste stream management stream.





Select solid-liquid separator. 





Clicking in the input cell for Step 2, for the example shown below, accesses the drop-down list of components that can be selected as a treatment/storage component for both liquids and solids.





Clicking in the input cell for Step 3, for the example shown below, accesses a drop-down list of components that can be selected to store runoff from the uncovered dry stack’s facility.





Click the � button when done editing the Runoff screen.





�


selected for the example shown.  





Click on box to check or uncheck months when withdrawal is planned.  Withdrawal is on the last day of the month checked.





Click on drop-down list to select shape of the pond to base the design on.





AWM computed dimensions for the example shown.





Enter the allowable specific discharge.  This value may be based on regulatory requirements.





Double click on animal.





Vary depth and bottom length to accommodate the site.





Click on box to check or uncheck months when withdrawal is planned.  Withdrawal is on the last day of the month checked.








Click on the  � check box if tank is covered to exclude precipitation.














Vary depth to accommodate the site conditions.





Click on drop-down list to select shape of the tank to base the design on.





Enter the preferred slope ratio and width of the ramp.























The NRCS design methodology is used unless the � is checked.





Click on drop-down list to select � or � dimension to base design on.





Click on drop-down list to select the shape of the lagoon to base design on. Choices are rectangular and circular.





Click on � to access the soil liner design screen.





Enter State Abbreviation.


Enter County Name.


Enter Climate Station Name.


Click on the � button.


Click on the � button to continue.


Enter climatic data for the new station.








Click on cell to be edited and then type in new value.





Select a directory in which to save the file.





Type in file name. 





Click on drop-down list and select �.





Click on the � button to save the file.





Click on � button.





If a one day curve number is selected, passing the mouse over the � (1-day) will display the 30 day curve number.








Click � button.





Click on the � button.





Click on the input cell and then edit or replace the existing data.





Click here to highlight animal line to be deleted.





Then press the [Delete] key on computer keyboard to remove the line of data from the database.











Enter the name of the animal to add.





Click here to access the drop-down list of animal types.  Click on an animal type to select it.





Select a State from the dropdown list and click on � button to add the animal type selected to the data table.





Animal added.





Enter animal data in accord with descriptions and units shown on the table.





Click on the drop-down list to select the animal type.





Click on the animal description in the choices list window and click the add button to select the highlighted choice.





To delete a row, click here to highlight the row, and then click on � button or press the [Delete] key on the keyboard.  





Click on “Edit Climate Data”





The differences in the AWM and MMP become apparent with the design of a manure storage facility that is subject to runoff inputs.  This is because the MMP estimates the runoff and rainfall entering a storage.  Thus, the most accurate assessment of a storage pumpable capacity and measured annual production volume is when the AWM is used to calculate the total annual production and storage capacity, and generate a report with the data by the AWM to be inputted into the MMP.  These are the steps:





Enter the name of the bedding data to be added.  In this example “New Bedding” is being added. 


Click on � button to add the “New Bedding” data.  The “New Bedding” data appears on first line.


Enter the density in pounds per cubic foot of the “New Bedding”.


Enter the effective density of the “New Bedding” in pounds per cubic foot.


Enter the State for which the “New Bedding” data is for.





Click on the input cell and then edit or replace the existing data.





Enter the name of the separator to be added.  In this example  “New Separator” is being added.  





Click on the � button to add the “New Separator” to the data table.





The “New Separator” will be added to the data table and will appear on first line.





Enter the separator efficiency as a decimal for the “New Separator”.














Click here to highlight the row of the bedding data to be deleted.





Press the [Delete] key on the computer keyboard to remove the line of bedding data.





Click on the input cell and then edit or replace the existing data.





Click here to highlight the row of the separator data to be deleted.





Press the [Delete] key on the computer keyboard to remove the line of separator data.








Click on �


and then click on �











Click on window topic on which help information is needed.





Click on the � button.





The animals selected are shown in the selected list window.





Click here to select a state.





Press the [Enter] key to select � or click on the appropriate button.





Revise values in resulting popup screen as necessary.





Select a State.





Click here to highlight the line of climate station data to be deleted.  





Press the [Delete] key on the computer keyboard to remove the line of data.





Click on January Prec input cell.





Select “Existing” tab for a list of all previously saved jobs.





Click on the desired file and click the � button to load the stored data into the AWM program from the selected file.





Click the � button when done editing the Locations screen.





Location that wash water is being calculated for.





Click the � button when done editing the Wash Water screen.





Location that flush water is being calculated for.





Click the � button when done editing the Flush Water screen.





Enter the amount of flush water used for each animal in gallons per head(animal).





Checking this box means the last data entering into the Flush Water screen will be saved and displayed the next time the screen is accessed.








MMP Storage Tab





MMP Analysis Tab





Click the � button when done editing the Management Train screen.





Program version:


Database version:





Same number for Spreadable or Pumpable Capacity to be entered into MMP “Storage” tab


(ignore manure production volumes)











Click on a Tab for the component to access the design screen.





Click on drop-down list to select the shape of the pond to base design on.





Click on drop-down list to select  � or � dimension to base design on.





Enter the permeability of the soil to be used for the liner.  This value is normally available from the soil mechanics report.





Vary depth to accommodate the site.





AWM computed dimensions for the example shown.





Click on drop-down list to access a list of months(1-12) to select a storage period from.





� option selected for the example shown.  





Click on the drop-down list to select the type of ramp to design.  Choices are Parallel and Perpendicular.





Click on � to access the ramp design screen.





Click on � to access the ramp design screen.





Click on � to access the conversion calculator.   The calculator can be used to convert centimeters per second to feet per day.  See the Calculator section in this chapter for more information. 





Click on � to access the soil liner design screen.





Enter the preferred slope ratio and width of the ramp.





Enter the preferred slope ratio and width of the ramp.





Click on the drop-down list to select the type of ramp to design.  Choices are Parallel and Perpendicular.





Click on � button to access the stage storage curve for the storage pond design.





Dimensions computed by AWM for the example shown.





�


option selected for the example shown.  





Click on drop-down list to select shape of the tank to base the design on.





AWM computed dimensions for the example shown.





Vary depth and width as needed to fit tank to site conditions and/or standard drawing.





�


option selected for the example shown.  





Click on drop-down list to access a list of months(1-12) to select a storage period.





Click on  � if tank is covered with a lid or roof to exclude precipitation.














Click on the drop-down list to select the type of ramp to design.  Choices are Parallel and Perpendicular.





Click on � to access the ramp design screen.





AWM computes the length of the ramp and shows the dimensions of the ramp on the schematic drawing of the storage pond.





AWM computes the length of the ramp and shows the dimensions of the ramp on the schematic drawing of the storage pond.





AWM computes the length of the ramp and shows the dimensions of the ramp on the schematic drawing of the rectangular tank.





AWM computes the length of the ramp and shows the dimensions of the ramp on the schematic drawing of the rectangular tank.





Enter the preferred slope ratio and width of the ramp.





Click on the drop-down list to select the type of ramp to design.  Choices are Parallel and Perpendicular.





Click on � to access the ramp design screen.





Click on drop-down list to select � or � dimension to base design on.





Click on drop-down list to select the shape of the lagoon to base design on. Choices are rectangular and circular.





Vary depth and bottom width to accommodate the site.





AWM computed dimensions for the example shown.





Click on box to check or uncheck months when withdrawal is planned.  Withdrawal is on the last day of the month checked.





�


selected for the example shown.  





Click on drop-down list to select shape of the lagoon to base the design on.  Choices are Rectangular and Circular.





Vary depth to accommodate the site.





AWM computed dimensions for the example shown.





�


option selected for the example shown.  





Click on drop-down list to access a list of months(1-12) to select a storage period.





Click on � to access the conversion calculator.   The calculator can be used to convert centimeters per second to feet per day.  See the Calculator section in this chapter for more information.





Click on � to access the soil liner design screen.





Enter the permeability of the soil to be used for the liner.  This value is normally available from the soil mechanics report.





Enter the allowable specific discharge.  This value may be based on regulatory requirements.





Enter the number of years for sludge accumulation.   At least 1 year of sludge accumulation period should be entered to account for sludge buildup in the lagoon.





Click on � to access the conversion calculator.   The calculator can be used to convert centimeters per second to feet per day.  See the Calculator section in this chapter for more information. 





AWM computed dimensions for the example shown.





The NRCS design methodology is used unless the � is checked.





AWM computed dimensions for the example shown.





Enter the number of years for sludge accumulation.   At least 1 year of sludge accumulation period should be entered to account for sludge buildup in the lagoon.





Enter the permeability of the soil to be used for the liner.  This value is normally available from the soil mechanics report.





Vary depth and bottom width to accommodate the site.





Click on � button to access the stage storage curve for the anaerobic lagoon design.





Click on drop-down list to select � or � dimension to base design on.





The NRCS design methodology is used unless the � is checked.





The NRCS design methodology is used unless the � is checked.





Click on drop-down list to select shape of the pond to base the design on.  Choices are Rectangular and Circular.





Vary depth to accommodate the site.





Enter the allowable specific discharge.  This value may be based on regulatory requirements.





The numeric keys on the calculator can be clicked on to perform mathematical calculations.   The numeric keys on the computer keyboard can be used for this purpose as well.





Click on the Calculator tab and the � button to edit existing conversion data or add additional conversion data.  





If the � box is checked the unit conversion factor will be available for use in the calculator.





Click on the � button to add additional conversion factors.





Click on the � button to view nutrient balance.





Enter the acres of each crop that manure and waste water is applied on.  





Enter the target yield goal for each crop in the units indicated next to the Yield Goal column.





Click on the � check box to indicate manure and waste water are incorporated into the soil when applied.  Leave blank if manure and waste water is not incorporated.





If available, enter recommended nitrogen, phosphorous, and potassium application rates in pounds per acre.








The data used in the conversion calculator can be edited by selecting Tools->Options from the main menu in AWM.





The calculator displays the value in square feet of the conversion of 2 acres shown in the previous screen. 





Enter the value of the unit to convert.  This example is converting 2 Acres to Square Feet. 





Click on the Convert button to perform the conversion.





Click on the “From:” drop-down list to select the unit to convert from.  Acre is selected for this example. 





Click on the drop-down list for unit type to select the type of unit to convert.  Area is selected for this example. 





Click on the “To:” drop-down list to select the unit to convert to.  Square foot is selected for this example.





Click on the � button to clear the input table.





Click on the � button to view help.





Select the data table to edit by clicking on the data element.





Select the directory to store the exported report file in. 


Enter the file name of the exported report file.


Click on the � button to open the report in the selected export file format.





Click on a report to select it for exporting. 


Click on the appropriate � button to select a Microsoft Word rich text format (.RTF) file or EMF file.


Click on the � button to export the selected file.





Click on the � check box to show sub reports. 


Click on the � check box to show state custom reports.


Click on a report to highlight it and then click on the � button to print the highlighted report.





Click on the � button to view the report as a rich text format (.RTF) file in Microsoft Word.  The report can also be saved as a rich text format or document (.doc) file using Microsoft Word. 


Use the zoom � tool to click on the report to zoom in or out on the report.


Click on the � button to print the report to the default Windows printer.  Use the File menu or press the [Ctrl] + [P] to select a different printer to print the report with.


Use the � buttons to preview different pages of the report.  The � button previews the next page and the � button previews the previous page.  The � button goes to the last page in the report and the �  button goes to the first page in the report.





Click on the � check box to show sub reports. 


Click on the � check box to show state custom reports.


Click on a report to highlight it and then click on the � button to preview the highlighted report.





A security warning popup may appear.  Simply click on the � button to view the report. 





Click on the preferred menu item in the drop-down list to print, preview or export a report.  





Click on the � button to view help.  





Click on the � button to create a rich text format (.RTF) file of the output form. 





Click on the � button to print the Manure Master output form.





Click the � button to close the output form window.





Click on the � button to view the following screen.





Select the directory in which to save the file.





Type in file name. 





Click on drop-down list and select �.





Click on the � button to save the file.





Change to the directory where the file to import is stored.





Click on drop-down list and select �.





Select the file to import.





Click on the � button to import the file.




















